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Metodološki problemi vrednotenja geodiverzitete: primer krajinskega parka Logarska dolina

Izvleček
Članek obravnava metodološke probleme vrednotenja geodiverzitete na primeru 
Krajinskega parka Logarska dolina. V njem sta predstavljeni in primerjani dve delno 
avtomatizirani metodi vrednotenja: prva združuje prostorsko odvisnost števila geo-
morfoloških in hidroloških elementov geodiverzitete s podatki o hrapavosti površja, 
druga pa upošteva tudi litološko sestavo. Indeksi geodiverzitete so bili izračunani z 
velikostjo rastrskih kvadratov 50 × 50 m z namenom primerjav in ugotavljanja po-
splošitev na preučevanem območju. Ugotovljeno je bilo, da vključitev litoloških ele-
mentov ni smiselna, če je litologija v vrednotenje že vključena preko geomorfoloških 
elementov, če z množenjem le poveča vrednost območij z visokim indeksom hrapa-
vosti ali če so si tipi litoloških enot glede na značilnosti podobni.
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METHODOLOGICAL PROBLEMS OF EVALUATING 
GEODIVERSITY: THE CASE STUDY OF THE LOGAR VALLEY 
LANDSCAPE PARK

Abstract
The article discusses the methodological perspectives of geodiversity evaluation with 
the case study of the Logar Valley Landscape Park. We present and compare two par-
tially automatized evaluation methods: the first merges spatial relation of the num-
ber of the geomorphological and the hidrological geodiversity elements with terrain 
ruggedness data, whereas the second includes the lithological elements as well. The 
indices were calculated for 50 × 50 m raster blocks for the purposes of comparing and 
determining generalisations in the studied area. It was concluded that it is not sensible 
to include the lithology into the evaluations if the lithology is already included into 
the evaluation with the geomorphological elements, if it only increases the value of 
the areas with high ruggedness index, or if the types of the lithologic units are similar 
to each other according to their characteristics.

Key words: geodiversity, geomorphology, diversity mapping, geomorphological ma-
pping, methodology, the Logar Valley, the Kamnik-Savinja Alps, Slovenia

1 UVOD
Človek se je svojega vpliva na okolje začel zavedati, ko je v njem pričelo primanjkovati 
naravnih virov ali pa so ti postali omejeni. S svojim delovanjem je vplival na podo-
bo in pestrost okolja, v katerem biva. Ko je bila ta podoba dovolj spremenjena in ko 
je bil manko določene dobrine okrnjen do meje izginotja, se je izoblikovala ideja o 
varovanju okolja. Sprva je to veljalo za živo naravo oziroma biotski del okolja (Gray, 
2004), kasneje pa se je skrb o varovanju povečala tudi za neživi oziroma abiotski del 
(Stepišnik, 2017). Za samo varovanje bodisi biotskega bodisi abiotskega dela okolja je 
bilo potrebno ugotavljati njuna stanja ter razviti metodologije vrednotenja in varova-
nja. Študije raznovrstnosti in raznolikosti narave iz leta v leto pridobivajo na pomenu. 
Raznovrstnost narave se v grobem deli na dve veji: biodiverziteto in geodiverziteto 
(Hjort, Luoto, 2010). Obe veji imata svoje značilnosti in ločen pristop preučevanja, 
sta pa medsebojno tesno povezani (Jačková, Romportl, 2008; Brazier in sod., 2012).  
Kljub temu pa pri vrednotenju biodiverzitete različni avtorji (npr. McCann, 2007; Ma-
claurin, Sterelny, 2008) poudarjajo, da se biodiverziteta območja ne more meriti le s 
preštevanjem različnih vrst, kar teoretično velja tudi za geodiverziteto, metodološka 
praksa pa tega še ne upošteva.
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Podobno kot za študije biodiverzitete Sarkar (2002) piše, da so prilagojene svoje-
mu namenu in da biodiverziteto lahko pripisujemo čemerkoli, kar se zdi pomembno 
v biološkem sistemu, se problem nepoenotenega načina preučevanja pojavlja tudi pri 
študijah geodiverzitete. Podobno kot obstaja pluralizem pri biodiverziteti, ki se nana-
ša na dejstvo, da je lahko isti sistem obravnavan na različne načine, ki so odvisni od 
namenov raziskav in njenih predpostavk, ter da morajo biti različni sistemi vrednote-
ni na različne načine (Maclaurin, Sterelny, 2008), tudi za geodiverziteto velja plurali-
zem v raziskavah. Če so študije geodiverzitete opravljene denimo v geokonzervacijske 
namene ali za namene urejanja okolja (na primer Gray, Gordon, Brown, 2013; Wang, 
Tian, Wang, 2015), bodo obsegale drugačno metodologijo in interpretacijo, kot če 
bodo namenjene izobraževanju (na primer Stepišnik, Ilc Klun, Repe, 2015). Analogno 
pluralizmu v biodiverziteti je tudi to, da se uporabljajo različni načini vrednotenja 
nežive narave v različnih okoljih. Na primer: določene študije vključujejo le izbrane 
elemente geodiverzitete (na primer geomorfološke in hidrološke v študiji Stepišnika 
in Trenchovske, 2017), druge pa jih vključujejo več (na primer Melelli, 2014).

Rezultati vrednotenja geodiverzitete se delijo glede na vrednost indeksa geodiver-
zitete; območja z visokim indeksom so območja, kjer je pestrost različnih elementov 
najvišja. Ta območja nekateri raziskovalci imenujejo vroče točke geodiverzitete (na 
primer Stepišnik, Repe, 2015) in imajo več potencialov. Prvi potencial se nanaša na 
varstvo okolja: območja z višjim indeksom so pestrejša in bi posledično lahko bila 
v pomoč pri določanju lokacij, ki bi se lahko dodatno zakonsko zaščitile (Bradbury, 
2014). Drugi potencial je pedagoški: območja z višjim indeksom so lahko bolj smisel-
na za pedagoške ekskurzije in terensko delo, če so dostopna (Stepišnik, Ilc Klun, Repe, 
2015). Tretji potencial je turistični: območja z višjim indeksom so lahko privlačnejša 
za turiste, če je ob njih ustrezna turistična infrastruktura. V teh primerih govorimo o 
geoturizmu, osnova katerega je specifična geodiverziteta (Wang, Tian, Wang, 2015).

Iz tega sledi, da je za popoln pregled nad tem, kaj geodiverziteta je, potrebno raz-
viti metodologijo, ki ne bo le seštevala različnih elementov in določala indeksov gle-
de na velikost vsote, ampak bo sledila sodobni metodologiji vrednotenja biodiverzi-
tete, upoštevala bo relevantne elemente abiotske narave, ne bo prilagojena namenu 
vrednotenja, njeni rezultati bodo primerljivi in aplikativni ter bo skladna z merilom 
preučevanega območja. Trenutni prispevek se osredotoča na analizo dveh obstoječih 
metod ter ugotavlja razlike med njima in rezultati, ki jih prinašata; glavna razlika med 
njima pa je upoštevanje litoloških elementov geodiverzitete.

2 METODE RAZISKAVE
Osnova kartiranja geomorfoloških oblik in morfografske analize ter inventariza-
cije elementov geodiverzitete in njenega vrednotenja sta bila temeljni topografski 
načrt v merilu 1:10.000 in lidarski model nadmorskih višin, ki je imel prostorsko 
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ločljivost 1 × 1 m (ARSO, 2015). Podrobno inventarizacijo geomorfoloških in hidro-
loških oblik smo izvedli, da bi lahko izdelali čim natančnejšo morfografsko karto. 
Slednja je služila kot osnova za nadaljnje prostorske analize, ki smo jih izvedli v Esrije-
vem programu ArcMap, v različici 10.5.1. LIDAR posnetki pa so služili za natančnej-
šo analizo in lokalizacijo elementov geodiverzitete ter za izračun hrapavosti površja. 
Opravljene analize in pridobljeni indeksi so bili narejeni za prostorsko enoto 50 × 50 
m rastrskih kvadratov. Velikost smo določili z namenom ugotavljanja primernosti ve-
likosti prostorskih enot z območji, ki so podobnih velikosti, kot je trenutno preučeva-
no območje. Glavne metodološke smernice vrednotenja geodiverzitete sledijo najpo-
gosteje rabljenim metodologijam, ki so jih do sedaj uporabljali slovenski raziskovalci 
(Stepišnik, Trenchovska, 2016, 2017; Stepišnik, Ilc Klun, Repe, 2017; Trenchovska, 
Stojilković, 2019).

2.1 Izbor elementov geodiverzitete

Prvi del raziskave je obsegal pregled temeljne literature o geodiverziteti in njenem 
vrednotenju (Gray, 2004; Serrano, Ruiz-Flaño, 2007) ter o preučevanem območju 
(Lucerna, 1906; Meze, 1966; Stojilković, Stepišnik, Žebre, 2013). Elementi geodiver-
zitete so bili identificirani in kartirani s pomočjo TTN v merilu 1 : 10.000 in LIDAR 
posnetkov (ARSO, 2018), slednji pa so bili uporabljeni tudi za nadaljnje računalniške 
analize. 

Preglednica 1: Vektorji posameznih elementov geodiverzitete.

Točka Črta Poligon
Hidrološki 
elementi

•	 izvir;
•	 ponor;
•	 slap;

•	 stalen vodotok;
•	 občasen vodotok;

/

Geomorfološki 
elementi

•	 vhod v jamo;
•	 vrh;

•	 krnica;
•	 sedlo;

•	 dolinsko dno;
•	 melišče;
•	 morenski material;
•	 območje podornih blokov;
•	 vršaj;

Litološki 
elementi

•	 lapor, peščeni skrilavec, skrilavi 
lapor, ploščati apnenec (skitij);

•	 svetlo sivi apnenec (anizij); 
•	 aluvij;
•	 masivni in debeloskladoviti 

apnenec;
•	 masivni kristalasti dolomit (anizij);
•	 morena;
•	 ploščasti apnenec (ladinij);
•	 pobočni grušč.
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Ker članek primerja različne metodologije vrednotenja geodiverzitete, sta bili za 
njeno ugotavljanje izbrani dve metodi. Obe vključujeta po dva sloja: vektorskega (ele-
mentov geodiverzitete) in rastrskega (indeksa reliefne razgibanosti). Prva upošteva 
geomorfološke in hidrološke elemente geodiverzitete, druga pa poleg njih še geolo-
ško podlago. Pri terenskem delu smo na TTN skartirali pet različnih vrst hidrolo-
ških oblik (izvire, ponore, slapove, stalne in občasne vodotoke), devet različnih vrst 
geomorfoloških oblik (vhode v jame, vrhove, krnice, sedlo, dolinsko dno, melišča, 
morenski material, območja podornih blokov in vršaje). S pomočjo geološke karte 
(Mioč in sod., 1983) smo določili tudi osem različnih vrst geoloških elementov (lapor, 
peščeni skrilavec, skrilavi lapor, ploščati apnenec (skitij); svetlo sivi apnenec (anizij); 
aluvij; masivni in debeloskladoviti apnenec; masivni kristalasti dolomit (anizij); mo-
rena, ploščasti apnenec (ladinij) in pobočni grušč). Posamezne oblike so bile nato 
digitalizirane bodisi v obliki vektorskih točk (izviri, ponori, slapovi, vhodi v jame in 
vrhovi) bodisi linij (sedlo, stalni in občasni vodotoki, krnice) ali pa poligonov (ostale 
geomorfološke in hidrološke oblike ter območja s posameznimi tipi kamnin). 

2.2 Indeks hrapavosti površja

Drugi korak je bila pridobitev sloja indeksa reliefne razgibanosti oziroma hrapavosti po-
vršja, ki smo ga izračunali s pomočjo lidarskega modela nadmorskih višin, z metodo, ki 
so jo razvili Riley, DeGloria in Elliot (1999). Indeks hrapavosti je pomemben, ker vklju-
čuje naklone v različne smeri neba, pobočja in posledično tudi sevanje, kar vpliva na 
hidrološke in geomorfološke procese ter procese v prsteh (Serrano, Ruiz-Flaño, 2007). 

Razgibanost površja je topografski element geodiverzitete, ponazoriti pa jo je 
možno z indeksom hrapavosti površja (ang. Terrain Ruggedness Index). Indeks pred-
stavlja razliko med vrednostjo celice in povprečjem osmih sosednjih celic (Cooley, 
2016). Izračun indeksa je bil izveden z orodjem Focal Statistics (Spatial Analyst Tools > 
Neighbourhood > Focal Statistics), kjer sta bili izvedeni dve analizi, ki sta se razlikovali 
v tipu statistike; slednji je bil enkrat minimalen, drugič maksimalen (Statistics Type: 
Minimum, Maksimum). Obe rastrski plasti sta bili uporabljeni za pridobitev rastra 
hrapavosti površja. Za izračun je bil uporabljen rastrski kalkulator (Spatial Analyst 
Tools > Map Algebra > Raster Calculator) in formula:

kjer je bil za izračun uporabljen koren absolutne vrednosti razlike kvadratov rastr-
skih vrednosti maksimalne in minimalne plasti. Programski izraz se je glasil:
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Posamezni razredi, v katere se običajno klasificira vrednosti indeksa hrapavosti 
površja po posameznih vrednostih, so: uravnano (0–80 m), skoraj uravnano (81–116 
m), malo hrapavo (117–161 m), srednje hrapavo (162–239 m), precej hrapavo (240–
497 m), zelo hrapavo (498–958 m) in izjemno hrapavo (959–4367 m) (ang. level, ne-
arly level, slightly rugged, intermediately rugged, moderately rugged, highly rugged in 
extremely rugged) (Riley, DeGloria, Elliot, 1999; Cooley, 2016). Za potrebe vrednote-
nja geodiverzitete delitev v te razrede ni potrebna, saj je za izračun indeksa geodiver-
zitete pomembna vsaka posamična vrednost indeksa hrapavosti površja in ne razredi, 
v katerih se te vrednosti nahajajo.

2.3 Rasterizacija in statistična analiza rastrskih slojev

Po izrisu vektorske morfološke karte in po izračunu indeksa reliefne razgibanosti smo 
geomorfološke in hidrološke vektorske sloje pretvorili v rastrske (Conversion Tools 
> To Raster > Point/Polygon/Polyline to Raster). Rastrski sloji so namreč potrebni za 
nadaljnje analize. Posamezen rastrski kvadrat je bil velikosti 1 × 1 m.

Orodje Block statistics je bilo uporabljeno za inventarizacijo na podlagi analize 
maksimuma. S tem orodjem smo ugotovili, ali so posamezni elementi znotraj celic ali 
ne. Orodje je bilo uporabljeno za geomorfološke in hidrološke sloje, ki so bili potem 
reklasificirani tako, da je bila vrednost 1 dodeljena celicam, kjer se elementi geodiver-
zitete pojavljajo, in vrednost 0 praznim celicam. 

Rastrski sloji so bili nato sešteti z uporabo rastrskega računala (Raster calculator). 
Seštevki v posameznih celicah so tako predstavljali skupna števila različnih elementov 
na prostorsko enoto.

2.4 Izračun indeksa geodiverzitete

V četrti fazi so bile z namenom primerjave različnih metod uporabljene različne 
enačbe za izračun indeksa geodiverzitete. Osnovno enačbo izračuna indeksa geodi-
verzitete sta predlagala Serrano in Ruiz-Flaño (2007):

kjer je Gd indeks geodiverzitete, Eg število različnih fizičnih elementov na enoto, 
R koeficient hrapavosti enote, S površina enote (km2) in Ln Napierjev (naravni) loga-
ritem (Serrano, Ruiz-Flaño, 2007). Enačba je za potrebe te raziskave modificirana, saj 
naravni logaritem ni bil uporabljen:

Dela_51_FINAL.indd   56 27.11.2019   10:37:24



57

Metodološki problemi vrednotenja geodiverzitete: primer krajinskega parka Logarska dolina

Pri prvi enačbi so za preračun indeksa geodiverzitete uporabljeni le geomorfo-
loški in hidrološki elementi ter hrapavost površja brez prsti, litologije. Praktično sta 
jo na primeru Regijskega parka Škocjanske jame uporabila Stepišnik in Trenchovska 
(2017). Druga enačba za razliko od prve upošteva litološke elemente geodiverzitete, 
ki sta jih na primer pri preučevanju geodiverzitete Krajinskega parka Rakov Škocjan 
upoštevala Stepišnik in Repe (2015).

2.5 Klasifikacija indeksa geodiverzitete

Rezultat vrednotenja, ki smo ga pridobili, omogoča razdelitev pridobljenih vrednosti 
indeksa geodiverzitete v razrede, ki naraščajo od zelo nizkega do zelo visokega za vsako 
homogeno enoto. V obstoječi literaturi (na primer Serrano, Ruiz-Flaño, 2007) so vre-
dnosti običajno razvrščene v pet razredov po Jenksovi klasifikaciji (Jenks, 1967), kjer 
prvi razred ustreza območjem z zelo nizkim indeksom geodiverzitete, drugi območjem 
z nizkim , tretji območjem s srednjim, četrti območjem z visokim in peti območjem z 
zelo visokim indeksom geodiverzitete (Serrano, Ruiz-Flaño, 2007). Ker pri takšni klasi-
fikaciji vrednosti razredov različnih vrednotenj niso enake, Jenksova klasifikacija (1967) 
tokrat ni primerna, saj primerjava pridobljenih rezultatov ne bi bila možna. 

Da bi bili rezultati obeh vrednotenj primerljivi, smo vrednosti normalizirali (Re-
scale by function) na intervalu od 1 do 100.

2.6 Primerjava rezultatov

Po pridobitvi zemljevidov indeksov geodiverzitete je bila potrebna njihova analiza 
in interpretacija razlik. S tem je bilo možno odgovoriti na vprašanja, če različne me-
tode pripeljejo tudi do različnih rezultatov, in s tem, kako ter v kolikšni meri izpust 
določenega tipa elementov vpliva na vrednotenje. 

V ta namen smo prekrili sloje in z ugotavljanjem deleža sprememb ugotavljali razlike. 
Delež sprememb smo izračunali z rastrskim kalkulatorjem, kjer  smo uporabili enačbo:

v kateri je Gd brez lit. predstavljal sloj indeksa geodiverzitete brez litoloških ele-
mentov, Gd z lit. sloj z njimi, K pa količnik oziroma sloj razlik. Pridobljen sloj smo 
nato interpretirali.
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3 KRAJINSKI PARK LOGARSKA DOLINA
Logarska dolina se nahaja na severovzhodnem delu Kamniško-Savinjskih Alp in 
meji na dolini Matkov kot na severu in Robanov kot na jugu. Od obeh dolin jo ločita 
vzporedna grebena. Dno doline poteka od vznožja krniškega dela doline na JZ, kjer 
z vrhovoma Kamniško-Savinjskih Alp Koroško (2433 m) in Štajersko Rinko (2374 
m) dosega svoje najvišje nadmorske višine (Hrvatin, 2010), do svojega konca ob Kle-
menčjih stenah. Od sosednjih visokogorskih dolin jo ločita gorska grebena, katerih 
nadmorska višina se od JZ postopoma znižuje do izteka dolin. Od Matkovega kota na 
skrajnem JZ jo ločuje nižji greben, ki se prične s Tursko goro (2251 m), od Kamniške 
Bistrice Brana (2252 m), Kamniško sedlo (1864 m) in Planjava (2394 m) ter od Roba-
novega kota Ojstrica (2350 m) in Krofička (2083 m) (Stojilković, 2013).

Površje Krajinskega parka Logarska dolina gradijo apnenci in dolomiti triasne sta-
rosti, po dolini pa v smeri SV–JZ poteka zmični prelom. Prelom se v južnem delu 
doline razcepi na dva dela, ki omejujeta Kamniško sedlo. Pobočja skrajnih JZ kr-
nic gradijo zgornjetriasni skladoviti dachsteinski apnenci, preostala pobočja krnice 
Okrešelj pa večinoma masivni dolomiti cordevolske formacije, ki so iste starosti. Na 
območju med Okrešljem in Klemenčo jamo so najpogostejši srednjetriasni ladinijski 
plastoviti in masivni apnenci, severneje do konca doline pa najdemo srednjetriasne 
anizijske masivne apnence in spodnjetriasne laporovce, plastovite in lapornate apnen-
ce ter peščenjake skitske formacije. Zahodna pobočja doline gradijo masivni dolomiti 
srednjetriasne starosti, ki se menjajo s spodnjetriasnimi kamninami skitske formacije. 
Dno doline v zgornjem delu zapolnjuje pleistocenski morenski material, ki je tudi na 
uravnanem delu obvisele doline Klemenče jame, srednji in spodnji del pa kvartarni 
rečni nanosi (Celarc, 2004; Stojilković, Stepišnik, Žebre, 2013).

Na razvoj površja Logarske doline je poglavitno vplivala tektonika, saj po dnu do-
line poteka zmični prelom (Mioč in sod., 1983). Površje je bilo v obdobju pleistocena 
večkrat poledenelo, dolinski ledeniki posameznih poledenitvenih sunkov pa so do-
segali različne dolžine (Lucerna, 1906; Meze, 1966). Ob višku zadnjega poledenitve-
nega sunka sta bila na območju doline dva ledenika: večji, dolinski, je z dolžino 4,8 
km tekel od krnice Okrešelj po dnu doline v smeri severovzhod; manjši, krniški, pa 
je imel dolžino 1,5 km in se je nahajal na območju Klemenče jame. Njuna skupna 
površina je bila približno 4,4 km2 (Stojilković, Stepišnik, Žebre, 2013). Zaradi tega 
lahko na območjih, ki sta jih prekrivala akumulacijska dela ledenikov, najdemo čelne 
in bočne morene umikalnih stadijev, če še niso bile erodirane. Zaradi kraških kamnin 
na območju stalnih vodotokov ni; suhe struge postanejo vodnate ob večjem in dolgo-
trajnejšem deževju. Ostale večje geomorfološke oblike so slapovi in slapišča, izviri in 
ponori reke Savinje ter jamski vhodi.

Območje je od leta 1987 zavarovano kot krajinski park z namenom trajne ohra-
nitve in posebnega varovanja te naravne znamenitosti (Odlok o razglasitvi …, 1987). 
Njegova površina je 2475 ha (Hrvatin, 2010). Istega leta so bili na območju Logarske 
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doline zavarovani tudi številni naravni spomeniki: Matkovo okno kot površinski geo-
morfološki naravni spomenik, Golarjev pekel in Klemenškov pekel kot podzemeljska 
geomorfološka naravna spomenika, slapišče Palenk, izvir Črne (Savinja) in Savinja od 
izvira do Ljubnega kot hidrološki naravni spomeniki (Odlok o razglasitvi …, 1987). 
Danes je na območju zavarovanih 43 naravnih vrednot, park pa v celoti sodi pod ob-
močje Nature 2000 (Krajinski park Logarska dolina, 2017).

4 VREDNOTENJE GEODIVERZITETE KRAJINSKEGA PARKA 
LOGARSKA DOLINA
Obe metodi izračuna indeksa geodiverzitete izhajata iz osnovne enačbe, ki sta jo raz-
vila Serrano in Ruiz-Flaño (2007). Pri vsaki od metod pa se razlikuje tip elementov 
geodiverzitete, ki so vključeni v izračun indeksa. Pri obeh metodah so pri izračunu 
uporabljeni geomorfološki in hidrološki elementi ter indeks hrapavosti površja, le pri 
drugi pa so uporabljeni tudi litološki elementi.

Litološke enote kot elementi geodiverzitete so bile pridobljene z Osnovne geo-
loške karte (Mioč in sod., 1983). Sprva so bile litološke enote v programu ArcMap 
digitalizirane kot poligoni. Slednji so bili nato pretvorjeni v rastrsko kvadratno obliko 

Slika 1: Krajinski park Logarska dolina (foto: B. Stojilković, 2018).
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Slika 3: Število litoloških elementov na prostorsko enoto.

Slika 2: Litološke enote v krajinskem parku.
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(Conversion Tools > To Raster > Polygon to Raster) s stranico dolžine 1 m. Dolžina je 
skladna z dolžino stranice rastrov geomorfoloških in hidroloških enot.

Rastrski sloj litoloških enot je bil nato uporabljen za ugotavljanje statistike pojavnosti 
litoloških enot znotraj kvadratov s stranico 50 m (Spatial Analyst Tools > Neighborhood 
> Block Statistics). Statistični tip, rabljen v analizi, je raznolikost (Variety), ki preračuna 
število edinstvenih vrednosti (ang. unique values) okoliških celic (kvadratov).

Litološke enote so bile glede na število posameznih enot v 50 × 50 m blokih razpo-
rejene v tri razrede. Največje število kvadratov (86,1 %) ima vrednost 1, kar pomeni, 
da se v njih pojavlja le po ena litološka enota. Kvadratov z vrednostjo 2 je 13,6 %, ležijo 
pa na mejah dveh litoloških enot. Najmanj je kvadratov z vrednostjo 3 (0,3 %), kjer 
se stikajo tri litološke enote. Kvadratov brez vrednosti (NoData) na tej plasti ni, ker je 
celotno območje prekrito z litološkimi enotami.

Vsi vektorski sloji geomorfoloških in hidroloških elementov geodiverzitete so bili 
pretvorjeni v rastrske sloje in s funkcijo Block Statistics analizirani. S tem smo ugo-
tovili pojavljanje posameznega elementa znotraj kvadratov velikosti 50 × 50 m. Po 
reklasifikaciji smo vse sloje sešteli.

Seštevanje reklasificiranih slojev je pokazalo, da na večjem delu preučevanega ob-
močja (70,4 %) geomorfoloških ali hidroloških elementov ni. Sledijo kvadrati s  po enim 
tovrstnim elementom; teh je 22,7 %. V 5,9 % kvadratov sta elementa dva, v 0,9 % pa 
so trije. V dveh kvadratih, ki predstavljata zgolj 0,02 % območja, pa so štirje elementi 

Slika 4: Glavne morfografske  in hidrološke enote v krajinskem parku.
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Slika 6: Seštevek geomorfoloških, hidroloških in litoloških elementov na prostorsko enoto.

Slika 5: Število geomorfoloških in hidroloških elementov na prostorsko enoto.
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geodiverzitete. Območja z višjimi vrednostmi se nahajajo predvsem v skrajnem spo-
dnjem delu doline na SZ, kjer se stikajo stalni in občasni vodotoki ter območje po-
dornih blokov. Ostala večja območja pestrosti pa so na območju krnice Okrešelj na JZ 
doline, na osrednjem južnem delu doline, kjer je ledenik akumuliral morenski material, 
ter v manjšem obsegu v osrednjem delu doline, kjer se stikajo vršaji, dolinsko dno in 
erozijski jarki. Naslednji metodološki korak je bilo prištevanje litoloških elementov.

Seštevek litoloških in geomorfoloških ter hidroloških elementov po posameznih 
kvadratih je pokazal, da je največje število posameznih elementov v bloku z vredno-
stjo 6, najmanj pa 1. V največjem številu kvadratov je en element geodiverzitete, kar 
predstavlja 61,36 %; tam se nahajajo le litološki elementi. Najvišjo vrednost (6) pa ima 
0,05 % kvadratov.  Območji se nahajata na skrajnem SZ doline, kjer se podorni bloki 
stikajo z vršaji in vodotoki, ter v osrednjem delu južne polovice doline, kjer se prav 
tako z vodotoki in vršaji stika morenski material. Preostale vrednosti so: 2–28,46 %, 
3–7,89 %, 4–1,93 % in 5–0,31 %.

Vrednosti indeksa hrapavosti površja se gibljejo med 0 in 950,208. Najnižje vre-
dnosti indeksa na prostorsko enoto so na dolinskem dnu v severni polovici doline, 
indeks pa nekoliko narašča po dolinskem dnu od osrednjega dela doline v smeri JZ. 
Nekoliko višji indeks je na vzhodnem in zahodnem pobočju doline, kjer je naklon 
večji. Najvišje vrednosti indeksa so tam, kjer je tudi naklon najvišji: na najvišjih nad-
morskih višinah doline oziroma nad melišči in v okolici krnic.

Slika 7: Indeks hrapavosti površja na prostorsko enoto.
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Slika 8: Indeks geodiverzitete brez litoloških elementov.

Slika 9: Indeks geodiverzitete z litološkimi elementi.
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Po izračunu indeksa hrapavosti in seštevanju elementov geodiverzitete na posa-
mezno enoto smo uporabili predstavljeni enačbi. S tem smo pridobili indeks geodi-
verzitete na preučevanem območju. Da bi ju lahko primerjali, smo vrednosti prido-
bljenih vrednotenj standardizirali tako, da smo jih razvrstili na intervala od 0 do 100.

Nato smo karti prekrili in delež spremembe med njima ugotavljali z enačbo   , 
kjer je spremenljivko a predstavljal sloj brez upoštevanih litoloških elementov, spre-
menljivko b pa sloj z njimi. Tako smo prikazali, za kolikšen delež (K) (od vrednosti 1) 
se spremeni koeficient geodiverzitete od sloja brez upoštevanih litoloških elementov 
do sloja z njimi.

Slika 10: Delež sprememb med indeksom brez in indeksom z litološkimi elementi.

Rezultati primerjanih metod se razlikujejo: najbolj skladni so na območjih, kjer 
je visoko število elementov na obeh kartah, ali pa kjer se elementi stikajo in kjer je 
tudi indeks hrapavosti površja visok. To so območja dolinskega dna, kjer se pojavljajo 
stalni ali občasni vodotoki, morenski material in vršaji. Prav tako so podobnosti na 
območjih krnic in podornih blokov. Odstopanja s pozitivno spremembo so na obmo-
čjih, kjer so občasni ali stalni vodotoki, kar je posledica množenja števila elementov 
z indeksom hrapavosti v osnovni enačbi. Na preostalih območjih pa so odstopanja z 
negativno spremembo, kar je posledica tega, da je karta z litološkimi elementi popol-
noma prekrita in da tako vedno vsaj en element vpliva na izračun indeksa geodiverzi-
tete, kar za karto brez litoloških elementov ne velja. Največja negativna odstopanja so 
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na območjih, kjer se stikajo posamezne litološke enote; tam je delež drugačen tudi za 
98,3 %, kar je na izbranem območju najvišja (oz. najnižja) vrednost. 

Če vrednosti klasificiramo po Jenksovi klasifikaciji, ki je najpogosteje rabljena 
klasifikacija pri vrednotenju geodiverzitete, ugotovimo, da v obeh primerih razredi z 
najvišjim indeksom sovpadajo na območjih krnic in melišč. Indeks je prav tako visok 
na tistih območjih, kjer se stikajo litološke enote, ki sovpadajo z geomorfološkimi ali 
hidrološkimi elementi. Srednji razred se pojavlja predvsem v tistih prostorskih eno-
tah, kjer se stikajo različni elementi geodiverzitete, ampak v manjšem številu. To je 
predvsem na pobočjih doline. Srednji razred je na karti, kjer so vključeni litološki 
elementi, bistveno večji kot na karti, kjer ti elementi niso vključeni, kar je posledi-
ca množenja litoloških elementov z indeksom hrapavosti, ki je na pobočjih z višjim 
naklonom večji. Do razlik prihaja predvsem na območjih, kjer je indeks hrapavosti 
nizek in je elementov malo (eden ali dva). 

Zelo nizek razred pa se med kartama precej razlikuje: na karti brez litoloških enot 
je z indeksom prekritih veliko prostorskih enot, ki so predvsem na pobočjih, kjer ni 
izstopajočih elementov. Nasprotno se na karti, kjer so vključeni tudi litološki elemen-
ti,  nizek indeks pojavlja predvsem na dolinskem dnu ali pa na pobočjih, kjer je izsto-
pajočih elementov malo. Nizek indeks geodiverzitete na dolinskem dnu in ob njem v 
primeru upoštevanja litologije, kljub številnim geomorfološkim in hidrološkim obli-
kam, je posledica večje uteži indeksa hrapavosti na pobočjih, kar pa se ne sklada z 
recentnimi interpretacijami geodiverzitete (na primer Melelli in sod., 2017; Stepišnik, 
Ilc Klun, Repe, 2017), kjer so za praktično rabo ugotovitev vrednotenja pomembni 
predvsem geomorfološki elementi.

Te ugotovitve kažejo, da so za vrednotenje geodiverzitete bistvenega pomena ge-
omorfološki in hidrološki elementi, litološki elementi pa le okrepijo vrednost inde-
ksa oziroma ga le delno spremenijo. Da bi litološki elementi pomembno in pravilno 
vplivali na vrednotenje geodiverzitete, bi morala biti njihova vrednost ovrednotena 
na smiselno velikih blokih, da bi se pokazale dejanske razlike v pestrosti, hkrati pa 
litološke enote ne bi smele biti enake, kot so geomorfološki elementi. Slednje ne drži 
za slovenske geološke karte (na primer Mioč in sod., 1983), ki kot litološke enote 
upoštevajo denimo morene in pobočni grušč, kar pa se že vključuje pri samih geo-
morfoloških elementih. 

5 SKLEP
Glavni cilj članka je bil predstaviti in primerjati dve delno avtomatizirani metodi 
vrednotenja geodiverzitete, pri čemer obe upoštevata geomorfološke in hidrološke 
elemente ter hrapavost površja, razlikujeta pa se po tem, da ena upošteva tudi litolo-
ške elemente, druga pa ne. S tem smo želeli ugotoviti, v kolikšni meri in na kakšen na-
čin litološke enote oziroma litologija vplivajo na vrednost indeksa geodiverzitete. Te-
kom raziskave so se izoblikovala različna stališča do obstoječih metod za vrednotenje 
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geodiverzitete, saj smo pri pregledu dosedanje literature ugotovili, da so bile slednje 
pogosto prilagojene namenu vrednotenja ali pa razpoložljivosti podatkov.

V raziskavi smo primerjali dve različici metode, ki sta jo razvila Serrano in Ru-
iz-Flaño (2007), v prvotni obliki pa sta jo zastavila kot zmnožek števila različnih fizič-
nih elementov s koeficientom hrapavosti, ki je deljen z naravnim logaritmom površine 
območja.   Upoštevajoč različne elemente ali v modificiranih oblikah je bila ta metoda 
uporabljena že pri številnih vrednotenjih (npr. Jačková, Romportl, 2008; Hjort, Luoto, 
2010; Melelli, 2014). V naši raziskavi prva metoda združuje geomorfološke in hidro-
loške elemente s hrapavostjo površja, druga pa geomorfološke, hidrološke in litološke 
elemente s hrapavostjo površja na preučevanem območju. Ugotovili smo, da se glede 
na razrede končnega indeksa geodiverzitete rezultati med metodama razlikujejo. 

Ugotovili smo, da vključenost (ali izključenost) litoloških elementov v vrednote-
nje pomembno vpliva na indeks geodiverzitete, kar se je zaradi različnih mnenj glede 
vključenosti ali izključenosti litoloških elementov odražalo tudi v dosedanji literaturi 
(npr. Najwer in sod., 2016; Trenchovska, Stojilković, 2019). Z vključenostjo litoloških 
elementov se vrednost indeksa poveča predvsem na območjih, ki ležijo na stikih posa-
meznih elementov, še bolj pa, če se ta območja skladajo z območji z visokim indeksom 
hrapavosti površja, ki že tudi sam delno upošteva reliefno energijo in pregibe v površ-
ju (Riley, DeGloria, Elliot, 1999). Zato je vključenost litoloških elementov smiselna pri 
vrednotenju geodiverzitete na območjih, kjer se pojavljajo različni tipi kamnin, in če 
to pomembno vpliva na druge elemente; če pa se pojavlja le en tip kamnin (denimo 
apnenec v določenih kraških pokrajinah), se ta element geodiverzitete pri vrednotenju 
lahko zanemari (kot npr. v Stepišnik, Repe, 2015; Trenchovska, Stojilković, 2019 idr.). 
Če so kamnine podobne in se ne razlikujejo bistveno niti v mehanskih niti v kemičnih 
značilnostih, njihova vključitev v vrednotenje ni smiselna, saj bo pretirano število geo-
loških elementov, ki so si podobni, imelo prevelik vpliv na končen indeks, ki v takšnem 
primeru ne bi bil realen, saj bi bil poudarek na določenem tipu elementov prevelik. Prav 
tako se litološka podlaga lahko zanemari, če ob množenju z indeksom hrapavosti le 
obteži vrednost indeksa geodiverzitete, praktične razlike za uporabo rezultatov vredno-
tenja ali v drugih elementih pa ne predstavlja, kar se je izkazalo v našem primeru, kjer 
so bili izrazito poudarjeni visokogorski predeli z velikim naklonom. Zadnji razlog, zakaj 
litološke podlage na takšen način ni smiselno upoštevati, pa je, da so z njo nekateri ele-
menti geodiverzitete (na primer pobočni grušč, melišče in območja podornih blokov) 
vrednoteni dvakratno, saj so vključeni in kot litološki in kot geomorfološki elementi.

Indeks hrapavosti površja se na preučevanem območju relativno sklada z nakloni, 
zato bi bilo v nadaljnjih raziskavah smiselno ugotoviti, ali je za vrednotenje geodiver-
zitete namesto indeksa hrapavosti mogoče uporabljati vrednosti naklonov na pro-
storsko enoto. Prav tako se je za problematično pri interpretaciji rezultatov izkazala 
lastnost metode, da se indeks hrapavosti množi z ostalimi elementi. Tako območja z 
večjim indeksom hrapavosti, četudi je na njih zgolj en element, dobijo veliko večjo 
vrednost kot območja z nizkim indeksom hrapavosti.
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Elemente geodiverzitete smo določili s pomočjo obstoječe literature, terenskim 
delom in daljinskim zaznavanjem. Podatki so bili nato obdelani v geografskih infor-
macijskih sistemih. Menimo, da bi bilo za namen primerjav med posameznimi ob-
močji v prihodnjih raziskavah za podobno velika testna območja treba določiti, kateri 
elementi so na tistih tipih površja primerljivi z elementi, ki smo jih vključili v vredno-
tenje pri tej raziskavi. Le na takšen način bi elemente na različnih območjih poenotili 
in tako zagotovili primerljivost rezultatov. 

Sklenemo lahko, da so bili cilji in namen raziskave doseženi. Ugotovljeno je bilo, 
da litološke enote vplivajo na indeks geodiverzitete, vendar vključitev teh elementov 
ni smiselna, če je njihov vpliv vključen že preko drugih elementov ali pa če preveč ob-
teži druge vrednosti pri vrednotenju. Prav tako smo ugotovili, da se morajo naslednji 
koraki razvoja vrednotenja geodiverzitete nanašati na definicijo ključnih poenotenih 
elementov vrednotenja, da bodo rezultati med raziskavami primerljivi. Tako prva 
predstavljena metoda praviloma predstavlja priporočeno osnovo za bodoč razvoj me-
todologije vrednotenja geodiverzitete in za aplikacijo na različna območja.
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METHODOLOGICAL PROBLEMS OF EVALUATING 
GEODIVERSITY: THE CASE STUDY OF THE LOGAR VALLEY 
LANDSCAPE PARK

Summary
Geodiversity started to develop as a response to predominantly biocentric approach 
to environmental protection. For its evaluation, many qualitative and quantitative 
methods have been developed in the past twenty years. The primary difference is that 
with qualitative methods the evaluator attributes a certain numeric value to an element 
according to his/her judgement, whereas with the quantitative ones only objective me-
asures apply. Hence, the quantitative ones mainly include terrain ruggedness and di-
fferent elements of the abiotic environment (geomorphologic and/or soil, hydrologic 
and lithologic elements). Some of them are also partially automatized in the geographic 
information systems.

The so far methods were mainly adapted either to the goal of the geodiversity 
evaluation or to available data. In this article, we compared two qualitative methods 
that have already been used at evaluations. The first one merges the geomorphologic 
and the hydrologic elements with terrain ruggedness, whereas the second one in-
cludes also the lithologic elements in the study area. The study area was The Logar 
Valley Landscape Park, which is situated in the Kamnik-Savinja Alps in the north 
of Slovenia. Firstly, we mapped the geodiversity elements using the so-far literature, 
fieldwork, remote sensing and LIDAR data. Next, those elements were analysed in the 
ESRI ArcMap GIS programme. While calculating the geodiversity index, we omitted 
the natural logarithm, which is sometimes used for geodiversity evaluation, because 
we did not compare two different areas.

The results of the geodiversity evaluation among the two methods differed. The ge-
odiversity index changes significantly if the lithologic elements are excluded from the 
evaluation. If those elements are included, the index gets a much higher value in the 
areas where it overlaps with high terrain ruggedness index. The reason for this is that the 
present equation multiplies the ruggedness index with other elements. Because of that it 
is sensible to include the lithologic elements only if different rock types occur and only 
if those occurrences affect other elements. Whereas if there is predominantly only one 
lithologic element in the study area, it can be omitted from the evaluation. Secondly, the 
lithologic elements can also be excluded if they only contribute to higher geodiversity 
index in the areas where there is also high terrain ruggedness index – namely, the two 
are multiplied in most of the studies – whereas there is no practical use or difference 
for the usage of the evaluation results. If the rock types do not have any crucial physical 
or chemical difference among them, their inclusion in the evaluation is not sensible. A 
too big number of the similar geological elements would cause a too big impact on the 
final evaluation result. The last reason why the lithologic elements do not need to be 
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included in the evaluation is that some of them – such as scree slopes or gravel, which 
are geomorphological elements – are already included as other element types and they 
should not be included more than once.

In the study area, the terrain ruggedness index mainly overlaps with slope – where 
there is high terrain ruggedness index, the slope is also very steep. That is why further 
studies could investigate whether it would be possible to include the slope and in-
clination data instead of the ruggedness index in a block for the geodiversity index. 
Another issue that arose during our study is that the value of the ruggedness index is 
multiplied with other elements: in that way the elements with high ruggedness index, 
even if there is only one other element in the same block, are attributed a much higher 
value than the areas with low ruggedness index.

To sum up, the results of our comparative research have shown that it is necessary 
to re-think the elements that are included in the geodiversity analyses. The present 
methods do not distinguish sufficiently between different elements, nor do they bring 
results that could be generally used for different purposes. Since the definition of geo-
diversity developed based on biodiversity, also the evaluation methodology should be 
tailored to the biodiversity evaluation model. Only if all these conclusions are taken 
into consideration, it will be possible to make comparisons between different study 
areas or to make further – joint – studies of environmental diversity.

(Translated by the author)
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